SharePoint 2016
Web Publishing Manual
# Table of Contents

SharePoint Login ....................................................................................................................... 4
Exploring the Web Publishing Environment ............................................................................. 4
    Site Actions Menu .................................................................................................................. 4
    Recycle Bin ............................................................................................................................ 5
    Context Sensitive Ribbon ....................................................................................................... 6
Text Editing ................................................................................................................................ 7
    Copying/Pasting Text ............................................................................................................. 7
    Text Formatting ...................................................................................................................... 8
Uploading and Inserting Images ................................................................................................. 8
    Uploading Images into the Images Library .............................................................................. 8
    Creating Image Folders .......................................................................................................... 9
    Inserting an Image on a Web Page .......................................................................................10
    Image Placement Requirements ............................................................................................11
Uploading and Downloading Documents ................................................................................... 11
    Uploading Documents to the Documents Library .................................................................11
    Creating Document Folders ...................................................................................................12
    Downloading Documents from a Documents Library ...........................................................12
Creating Links ........................................................................................................................... 13
    Link to another Web Page .....................................................................................................13
    Link to a Document ..............................................................................................................13
    Link to an External Web Page ...............................................................................................14
    Removing a Link ....................................................................................................................15
    Changing the URL of an Existing Link ..................................................................................15
    Link to an Email Address ......................................................................................................16
Inserting Tables ........................................................................................................................ 16
Creating New Pages .................................................................................................................. 19
Changing Page Layouts ............................................................................................................ 20
Editing Web Page Properties .................................................................................................... 20
Saving a Web Page ................................................................................................................... 20
Page History ............................................................................................................................. 23
Modifying Navigation ............................................................................................................... 24
    Current Navigation ...............................................................................................................24
Adding Links to the Current Navigation (or Quick Launch) ..........................................................26
File Naming Conventions ..............................................................................................................26
Accessibility Guidance ..................................................................................................................27
Alternative Text ..........................................................................................................................27
Headings .......................................................................................................................................28
Links ..........................................................................................................................................29
Color .........................................................................................................................................29
Changing Text Color and Checking Color Contrast ......................................................................30
SharePoint Login

The SharePoint Login link is found in the website footer. To log in, enter your username and network password.

After logging in, you are taken to the SCCOE home page. Navigate to and access the sub-site(s) you have authoring permission for. The editing tools will only appear in sites you are granted access to.

Exploring the Web Publishing Environment

Site Actions Menu

The Site Actions menu only appears in the site(s) you have authoring permission for.

1. Click on the gear icon on the top right corner.
2. Click on Site contents.
You are taken to the Site Contents area, which is the main repository for your site content.

There are three main libraries in each site:

- **Documents** - This is where you will upload and store documents (i.e. existing files) that you link to on web pages.
- **Images** - This is where you upload and store pictures and graphics that you place on web pages.
- **Pages** - This is where web pages are stored. Notice there is an existing page already in your Pages Library named "default.aspx". This is your home page for the site and is created automatically when a site is created in SharePoint.

**Recycle Bin**

Whenever you delete an item stored in a library (i.e. a document, image, or page) the item is sent to your site's recycle bin where it stays for 60 days. Use your Recycle Bin to restore an item to the location where it was deleted from.

*Note: Your site's Recycle Bin is a completely separate recycle bin that appears on your Windows desktop.*
**Context Sensitive Ribbon**

The ribbon is a dynamic toolbar that appears across the top of each page. It displays different tools, controls and commands corresponding to the selected tab.

To show editing tools on the ribbon, select **Edit Page** from the Site Action menu, then click on each tab on the ribbon to view related controls.

![Image of ribbon showing options]

**Text editing tools:**

![Image of text editing tools]

**Page tools:**

![Image of page tools]

**Insert tools:**

![Image of insert tools]
Text Editing
Open the page you want to edit in the browser

1. Select **Edit Page** from the Site Actions dropdown
2. Click on the **Page** tab in the ribbon toolbar

Review the options available on the Page ribbon. This is one of many ribbon toolbars that are included in Exploring Web Publishing Environment.

Note: if some icons are "grayed out" this means you do not have access to the option.

**Copying/Pasting Text**
Copy text content from the current site or from a source Word document

1. Place your cursor inside the Page Content area
2. Select **Paste > Paste plaintext**

*Note: The paste plaintext option helps remove inline styles from the original source.*
**Text Formatting**
The standard body text style is applied to the page content by default. You don't need to change it.

To be compliant with web accessibility, you should structure your page with headings. To be compliant to web accessibility guidelines, you should structure your page with headings. Screen reader users will navigate the page content through headings.

**H1** is the page title, already applied when you create a new page.

**H2, H3, H4…** are used to structure your page content.

To keep the text formatting consistent across the whole site, always use the Markup Styles to format your text. It is not accessible or recommended that you create your own bold and big text with different colors to replace headings.

---

**Uploading and Inserting Images**

**Uploading Images into the Images Library**
Upload your images before using them on your web pages.

1. Select **Site Contents** from the Site Actions dropdown
2. Open the **Images** Library

   ![Images Library](image)

3. Click on **Upload**
4. Click on the **Choose File** button to browse to a single image file to upload, or drag and drop into the **Drag files here to upload** to upload multiple files at the same time.

---

**Creating Image Folders**

Images of the same category can be organized in a separate folder created under the Images Library.

1. Open the **Images Library**
2. Select **New Folder** under the **Files** tab
3. Name the new folder
4. Open the new folder
5. Click on Upload or drag and drop images into the folder

**Inserting an Image on a Web Page**

1. Place your cursor inside the Page Content area and click on the Insert tab on the ribbon.
2. Click on the arrow under the Picture icon, and select From SharePoint.
3. In the Select an Asset window, browse to the location of your image file (uploaded into your Images Library in previous steps), click on the image file name, and then click the Insert button.
4. Select the newly inserted image to display the Picture Tools on the ribbon, and **add an Alt Text attribute** that is meaningful for the image. See Alt Text section below.
   
   **Note:** If the image is only for decorative purpose, leave the Alt text field blank.
5. Edit other properties if needed i.e. the Position property can be used to align the image on the page.
**Image Placement Requirements**

- You must use one of the 3 following file formats:
  - **JPG** - for photos
  - **GIF** - for graphics with solid colors
  - **PNG** - graphics with solid colors or with a transparent background (e.g. logo, buttons, saved from vector graphics)
- Your image must be sized -- your image should be resized respective to the intended use prior too uploading into the Images Library.
- Avoid using very big file sizes for page content because this will slow down page loading time. Less than 200KB file size is recommended.
- Do not upload large image file and resize and then resize the image to a small picture on the web page (for example: 3600px width scaled to 200px)
- If you use Photoshop or another image editor software, select the "Save for Web..." or the "Export" option to optimize your images for web use.
- Images must be uploaded to Images Library before inserting them to web pages.
- Add Alt text (please read below)
- Position as needed (float left/right)

**Uploading and Downloading Documents**

**Before linking to your web pages, documents should be uploaded to the Documents Library.**

PDF file format is recommended for documents used for the web.

**Uploading Documents to the Documents Library**

1. Go to **Site Actions**, select **Site content** and open the **Documents Library**.

2. Click on **Upload**.
3. Click on the **Choose File** button to browse to a single image file to upload, or drag and drop into the **Drag files here to upload** to upload multiple files at the same time
Creating Document Folders
Documents of the same category can be organized in a separate folder created under the Documents Library.

1. Open the Documents Library
2. Select New Folder under the Files tab
3. Name the new folder
4. Open the new folder and upload documents

Downloading Documents from a Documents Library
To download a document from the Documents Library, select the document and then click "Download a Copy" from the ribbon.
Creating Links
In the page content area you can create 3 types of links: link to another web page, link to a document, and external link.

**Link to another Web Page**
1. Highlight the text you wish to make a link.
2. Select the **Insert** tab.
3. Select **Link** and then select **From SharePoint**.
4. In the **Select an Asset** dialog box, click on the **Pages** library link on the left bar to display all web pages.
5. Select the page you want to link and click OK.

**Link to a Document**
1. Highlight the text you want to make a link
2. Select the **Insert** tab.
3. Select **Link** and then select **From SharePoint**.
4. In the **Select an Asset** dialog box, click on the **Documents** library link on the left bar to display all documents.

5. Select the document you want to link and click OK.

Tip: From the **Select an Asset** dialog box, you can upload a new file to link to. Select the appropriate documents library (Documents or Pages) on the left pane to open it, click on the **Upload** link, and upload your file to that specific library. Then, you can create a link to the newly uploaded file.

**Note: A link to a document should open a new window:**

1. Click inside the text of your newly created link to expose the **Link** menu in the ribbon.
2. Check **Open in new tab** under Link Tools /Format on the ribbon.

---

**Link to an External Web Page**

1. Highlight the text you want to make a link.
2. Select the **Insert** tab.
3. Select **Link** and then select **From Address**.

4. In the **Insert Hyperlink** dialog box, enter the URL of the web site or web page you want to link to.
Note: External web page should open in a new window.

1. Place your cursor on the existing link to expose the Link menu in the ribbon.
2. Check Open in new tab under Link Tools /Format on the ribbon.

Removing a Link
1. Place your cursor on the existing link to expose the Link menu in the ribbon.
2. Click on Remove Link on the ribbon.

Note: Deleting an existing link in the URL field does not remove it completely. The link still remains, but points to the default page. To remove a link completely, click on the Remove Link icon.

Changing the URL of an Existing Link
1. Place your cursor on the existing link to expose the Link menu in the ribbon.
2. Click Select Link icon.
3. Select a document or web page from the SharePoint site. For external link, enter a URL in the Location (URL) field and check **Open in a New Tab**.

**Link to an Email Address**
1. Highlight the text you wish to make a link.
2. Select the **Insert** tab.
3. Select **Link** and then select **From Address**.

4. Enter mailto: following by email address (no space between mailto: and the email address)

**Inserting Tables**

**Inserting a Table:**
1. Select the **Insert** tab.
2. Select **Insert Table**
3. Select the number of rows and columns

Table Layout Tools:
Select the **Table Layout** tab.

- **Delete cell, column, row, or whole table:**
  Select the element you want to delete, and then click on the corresponding option on the **Delete** dropdown.

- **Insert rows and columns:**
  Select the row or column you want to insert a row or column next to it, and click on the corresponding option on the ribbon.
• **Split and merge cells:**
  - **Split:** Select the table cell to split and then select the corresponding option on the ribbon.
  - **Merge:** Press the Shift key and select the cells to be merged, then select the corresponding option on the ribbon.

**Table Design:**

Click on the **Design** tab, and then select a **predefined table style**.

The **Clear** table style is used to line up text blocks or graphics in columns and rows (this style has no borders).

Options to display column and row headers:

**Table Sizing:**

- Use relative values (percentages) rather than pixels.
- Defining cell height should be avoided so the table cell can expand downward to accommodate its content.
Creating New Pages

To create a new page:

1. Go to the site you want to add a new page to.
2. Select **Add a Page** from the Site Action menu.

3. Enter the new page name and click **Create**.

   ![Add a page screen](https://example.com/addpage.png)

   **Note: see File Naming Conventions section of this guide**

4. The new page will open for you to start editing.
   a. Edit the page title in the **Title** field if needed.
   b. Edit the page content.

**Notes:**

- Page Titles are different than page names: page titles appear on top of the web pages, they should contain spaces. Page names are file names, they should not contain spaces.
- The link to the newly created page is automatically placed on the current site navigation bar after you published it. You could disable this feature in the Navigation...
Settings and add links manually to the current site navigation (see Modifying navigation / Current navigation section of this guide).
- New pages are stored in the site’s Pages library.

**Changing Page Layouts**

To change the page layout, you need to be in edit mode.

1. Select **Edit** tab and then select **Page** tab.
2. Select a page layout from the **Page Layout** dropdown.

**Editing Web Page Properties**

You can change the file name, title, and others page elements for an existing web page by editing its properties.

To open the page properties, select **Edit Properties** under the **Page** tab.

**Saving a Web Page**

There are 3 options for saving and closing a web page:
• Save - Save changes to the page and exit edit mode
• Save and Keep Editing - Save changes to the page and continue editing
• Stop Editing - Exit edit mode on this page. You will be prompted to save or discard your changes.

When you open a web page in edit mode, it is checked out to you. The status bar shows that the page is "checked out to you" and "only you can see your recent changes".

![Image showing edit mode options]

When a page is checked out to you, other permitted users cannot see your changes, and cannot edit that page until you check it in.

Check In options
• **Check In** - Check in the page which is currently checked out to you.
• **Discard Check Out** - Discard any changes you have made to your checked out version.

While you are working on the update and save your page, your changes are not visible to the public. You need to publish your page for the update to be viewable by the public.

Select **Publish** tab and click **Publish**.

Add any comments and then click the Continue button. Note: comments are optional, but are used in the Version History (see **Page History** section) so it is recommended to add a brief summary of the changes made.

A note about page versioning…

SharePoint creates a minor version of a page each time you check it in. A major version is created each time you publish a page. The current live page is the latest major version.

Major versions are always in whole numbers, such as 1.0, 2.0, and so on. Minor versions are denoted by decimals following a major version number, such as 1.1, 1.2, 1.3 and so on. For example, suppose the latest minor version of a page is 4.3, when you publish the page the next major version will be 5.0. See **Page History** section below for more information page history.
Page History

Each web page has a version history. The number of major and minor versions can be set in Page Library Settings > Versioning Settings. You can use the Page History to restore a previous version of a page.

To view Page History:

1. Select the Page tab on the ribbon.
2. Select Page History.

To restore a previous version:

For example: Your current published major version is 42.0 and you want to restore the previous version 40.0.

1. Click on the down arrow on the right hand side of version 35.0 date
2. Select Restore from the dropdown menu
It is important to know how to access the version history for your page should you need to revert back to a previous version.

**Modifying Navigation**

**To modify the site navigation:**

1. Select **Site Settings**.
2. Under **Look and Feel**, select **Navigation** to open the **Navigation Settings** page.

You can do the following modifications:

- Show/hide global and current navigation links
- Sort links automatically or manually
- Move links up and down (links on the current navigation are set to be sorted manually)
- Edit links and headings
- Add/Delete links and headings

**Note:**

- The **Edit** and **Delete** options are not available for a link that is populated automatically on the current navigation when you create a new page, or new subsite.
- The **Edit** and **Delete** options are available for links that are manually added to the current navigation.

**Current Navigation**

The **Current Navigation** settings allow you to configure options for your site’s navigation menu.
Current Navigation

Specify the navigation items to display in current navigation for this Web site. This navigation is shown on the side of the page in most Web sites.

- Display the same navigation items as the parent site (Parent is using Structural Navigation.)
- Managed Navigation: The navigation items will be represented using a Managed Metadata term set.
- Structural Navigation: Display the current site, the navigation items below the current site, and the current site’s siblings
- Structural Navigation: Display only the navigation items below the current site

- Show subsites
- Show pages

Maximum number of dynamic items to show within this level of navigation: 20

Structural Navigation: Sorting

Specify the sorting of subsites, pages, headings, and navigation links within Structural Navigation.

- Sort automatically
- Sort manually

Structural Navigation: Editing and Sorting

Use this section to reorder and modify the navigation items under this site. You can create, delete and edit navigation links and headings. You can also move

---

Current (Site) Navigation Menu

---
Show Subsites & Show Pages

- With the Show Pages option checked, a link to a new page is automatically added to the current navigation bar when you create it. The corresponding link will be automatically removed from the left navigation bar when you delete a page.
- With the Show Pages option unchecked, links are not populated automatically on the current navigation menu when you create new pages. You will have to add links manually using the Add Link... in the Navigation Editing and Sorting section. In this case, you should add a Home link to go back to the home page.

The Show subsites option works the same way.

Adding Links to the Current Navigation (or Quick Launch)

To add a link manually to the current navigation:

1. Click on Add Link.
2. Enter the link title or page title to the Title field.
3. Use the Browse button to browse to the page you want to link.
4. The link will be populated to the URL field.
5. Click OK.

Note:

- To create a link to an external website, copy the URL (web address) of that website, paste it to the URL field and check Open Link in a new window. That is to avoid losing you main site when the external site opens on top of it.
- For link to a document (PDF or Office document), Open Link in a new window must be checked.

File Naming Conventions

Avoid using spaces for subsite names and file names.

Spaces will be replaced by %20 and display an unfriendly URL:


Replace spaces with dashes (-) or use a no-space compound word with “camel case.”

Web pages:

https://www.sccoe.org/Departments/Testing/Pages/Network-Support-Services.aspx

Documents:

Naming convention for subsites: no-space and camel case
Website: https://www.sccoe.org/Departments/BusinessServices

Accessibility Guidance

Alternative Text
To comply with Web accessibility standards when placing images and graphics on pages, always remember the alternative text or “Alt Text” needs to be reviewed for every image placed on a web page.

Here are some general guidelines on the use of alt text:

- **Images that are part of your content.** If the image conveys information, then the Alt Text should convey the same information in the context of the page. Below are examples of Alt Text for the same image of Winston Churchill used in two different contexts:

  **First Context:** Web page on hats worn by well-known historical figures
  **Alt Text:** Winston Churchill wearing his signature Homberg hat
**Second Context:** Web page on Cuban cigars  
**Alt Text:** Churchill smoking his favorite Cuban cigar, Romeo y Julieta

- **Empty Alt Text for Decorative Images.** If the purpose of the image/graphic is to provide "eye candy" (i.e. visually setting a mood) then Alt Text should be blank (alt=""). An image with an empty Alt attribute (Alt="") is ignored by screen readers.  
  **Note:** When you insert an image in SharePoint, an empty Alt Text is inserted by default. Leave it alone if it is a decorative image. Add a descriptive Alt Text if the image is meaningful or functional.

- If the image is redundant or conveys no information, the Alt Text should be blank (alt="").

- **Linked Image.** If the image is an active link, it must have a meaningful Alt Text attribute, which specifies the function of the image (i.e. what the target of the link is).

  The Alt Text of the about image should be “View our event calendar for current course offerings and registration” as this is the function of the link.

- In all instances of Alt Text, avoid entering “picture of…” or “image of…” or “link to…” etc. as screen reading software already informs the user of this when they encounter an image or link.

- Complex images that require lengthy text descriptions (e.g. graphs and charts) also need brief alt text to describe its basic function and then provided with longer text descriptions within the web page or a linked web page.

- **Additional resources:**  
  - [https://webaim.org/techniques/alttext/](https://webaim.org/techniques/alttext/).

**Headings**

Your webpages need to be organized using headings and lists found under the Paragraph and Styles sections. Use Paragraph, Heading 2, and Heading 3. This is a great opportunity to update your webpages and restructure your navigation.
- **Correct reading order:** Organize and structure your page content with headings. Screen reading programs provide a mechanism to allowing people who are visually impaired to navigate through a list of headings.

- **A first level heading (h1) should be present.** In the SCCOE website, H1 is present by default as the page title.

- **A good heading hierarchy is required.** If you have a page content structured with headings, they should be nested properly and heading levels should not be skipped. Keep in mind that your page title is an H1. To avoid skipping heading levels, do not start your page content with h3 or lower level headings (h4, h5, h6). You can start your page content with h1 or h2. If your pages is very short, additional headings are not required.

- **Heading tag should not be empty.** Empty heading is an accessibility issue and should be avoided.

  **Note:** If you want to add a space on top of a heading, put your insertion point at the beginning of the heading, press the SHIFT key and hit ENTER to insert a line break. Avoid hitting ENTER without pressing the SHIFT key, because this will add an empty heading tags.

**Links**

A hyperlink is a call to action. Using links like "click here" or "learn more," are confusing for screen reading technology, as they provide no context. Ensure all links identify what content is provided when clicked.

- **Provide meaningful link text.** Screen reader let users know the presence of a link and typically do not use a mouse, so avoid using "Link to…", "Click here", or "Click on this link" to indicate a link. Other non-informative link phrases to avoid are: "Here", "More", "Read more", "Learn more", "Info"...

- **Avoid repetitive links of the same exact text.** For example, if you had a pad with a list of meeting dates and associated links to agendas, do not repeat "View Agenda" over and over again for each meeting. Instead, create the link in context and use “07-15-19 Meeting Agenda” or some other method of distinguishing the link.

- **Image Link must have a meaningful Alt text.** Alt text of an image link is read by screen readers, so it should be meaningful link text. See Alt Text section.

- **Empty link should be removed.** Usually, empty links are left-over links in the code. Since an empty link has no link text, it is invisible on the page and can only be removed in the HTML code view. The site auditing service “Site Improve” will flag empty links and publishers will need to remove them.

**Color**

Make sure the contrast of text and background colors are high enough. Use the Styles section and you’ll be good to go!
**Never use color alone to communicate.** People who are color blind or severely visually impaired cannot visually discriminate on the basis of color.

*For example, the following instructions would not be accessible: “Please see red text below for instructions on how to register.”*

**Color contrast is required.** Text and background colors should have enough contrast to pass accessibility validation.

Below is a result of the Contrast Checker Tool ([http://webaim.org/resources/contrastchecker/](http://webaim.org/resources/contrastchecker/)).

Note: Hexadecimal color codes (i.e. #F0F0F0) should be used to check color contrast.

Colored and highlighted text should not be used as visual indicator to convey the meaning of content.

Reason: People who are blind, colorblind, or have low-vision are not able to differentiate which text part you want to emphasize by using a different color or highlighted text.

*For example, the following instructions would not be accessible: “Please see red text below for instructions on how to register.”*

**Changing Text Color and Checking Color Contrast**

The SCCOE website has standard colors for text, headings and hyperlinks. To keep the color scheme consistent throughout the whole site, changing text color is not recommended. However, if color changes are needed for unique publishing needs, the below guidance is provided.

**To change text color in the page content:**

1. Highlight the text you wish to change color.
2. Select **More Colors...** from the text color dropdown to display the color picker.
3. Get the hexadecimal color code:
   a. Select a color swatch and copy the hexadecimal color code in the New Color field. For example: #66CCFF for text color and #FFFFFF for background color.
4. Check Color Contrast:
   a. Open the WebAIM Color Contrast Checker web page (http://webaim.org/resources/contrastchecker/).
   b. Paste the color code #66CCFF to the foreground color field (text color field), and #FFFFFF to the background color field.
   c. Note, in this example, this color is too light on a white background. The color contrast fails for both normal text and large text.

![Color Contrast Checker](image-url)
5. Modify Color Contrast:
   a. To increase the color contrast, slide the Lightness control to darken the foreground color until it passes color contrast validation, depending on your use of color for normal text (e.g. body text, text box, quotation) or for large text (e.g. heading, title bar, banner).

6. Changing Text Color on your SharePoint web page:
   a. Copy the new color code (#005e8e) for a foreground color that passes color contrast validation.
   b. Go back to your web page in SharePoint, highlight the text part, open the color picker, and paste the new color code to the New Color field.
   c. Scroll to the bottom right of the color picker window and click OK.
Using WebAIM Color Contrast Checker Tool

The WebAIM Color Contrast Checker tool can be used to check and select a background and foreground colors that meets the color contrast requirement. You could use your own hexadecimal color codes or pick the foreground and background colors from the color picker that appears when clicking on the color fields. If the color contrast fails, Use the **Lightness** slider to adjust your preferred colors until they pass the color contrast validation.